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TRYING SOMETHING THAT HASNT BEEN DONE YET 

HERE IN OUR VERY OWN WEST VIRGINIA HOMETOWN. 

THE MAKESHOP ENTREPRENEURSHIP WORKSHOPS  

BY MESH DESIGN AND THE BOYS AND GIRLS CLUB

TIME TO DESIGN AND DREAM 
AND BUILD OUR OWN FUTURE. 



3

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING
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BE 
YOUR 
BEST 
SELF. 

YOUR GUIDE

WORKSHOP 1: YOUR BIG IDEA IN APPALACHIA

IDEA FESTIVAL! PITCH COMPETITION

WORKSHOP 2: VISUAL DESIGN

WORKSHOP 4: VISUAL DESIGN

DESIGN TRACK CODE TRACK

CHOOSE ONE!

WORKSHOP 5: VISUAL DESIGN

WORKSHOP 3: CODING

WORKSHOP 4: CODING

WORKSHOP 5: CODING



YOUR 
NEXT 
BIG 
IDEA
FOR 
APPALACHIA.
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WORKSHOP 1:: ENTREPRENEURSHIP, AND CREATIVE PROBLEM SOLVING THROUGH DESIGN THINKING

5

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

*

5

Activities: 
×× Ideation and rapid prototyping

×× Mindmapping

×× Positive psychology strategy

×× Design thinking methodology

×× Place-based inquiry

×× Empathy mapping and empathetic 
design practices

Learning Objective
×× Creative Problem-solving

×× Resilience

×× Supportive Collaboration

×× Inquiry-Based Processing

×× Creative Confidence

×× Visioning Agency

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

WHAT DOES APPALACHIA  
NEED FOR OUR NEW 
FUTURE? WHAT DOES YOUR 
NEIGHBORHOOD NEED? 
The Plan 

1.	 Say Hello! Welcome and Introductions (15 minutes)

2.	 Selfie Mapping: New Look Who Dis? (5 minutes)

3.	 Mindmapping Strengths: Collaborative Brainstorming 		
		  Community Assets (10 minutes)

4.	 Challenge Map (10 minutes)

5.	 Empathy Interviewing (10 minutes)

6.	 Discussion (15 minutes)

7.	 Ideation: How to Intervene with a Positive change? (40 minutes)

8.	 Idea Sharing (15 minutes)

1
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ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1

SAY HELLO!

Welcome to the Makeshop Entrepreneurship 
Workshops! This is the time to say helloooo to 
your neighbors--we’re about to jump into a real 
adventure together. 

Go around the group and introduce yourself with 
your name, your favorite color, and your favorite 
thing about the place you live!

As everyone introduces themselves,  
make a sketch below of everyone!  

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1



98

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1 ENTREPRENEURSHIP, AND 

CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1

Mindmapping is the process of mapping lots of 
different really quick ideas together and drawing 
lines to map how they relate to each other! 

3 PEOPLE W
HO SUPPORT YOUR DREAMS

3 ACHIEVEMENTS

3 SUPERPOWERS

D
R

A
W

: S
E

LF
 P

O
R

T
R

A
IT

Your community

NEW LOOK WHO DIS?

SELFIE MAPPING!
Who are you when you pull back the curtain? 
Draw the prompts next to the triangles and share 
with your group!

WHAT ARE THE BEST 
THINGS ABOUT THE 
PLACE YOU LIVE?
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ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1 WHAT DOES YOUR 

NEIGHBORHOOD NEED?

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1WHAT ARE THE BIGGEST 

CHALLENGES IN YOUR 
COMMUNITY?

Your neighborhood 
needs...

Draw out 9 things that you really wish you could change  
about where you live. EMPATHY INTERVIEWING!

Write out what you think your neighborhood needs in 
the center and pass it to the person next to you to get 
a new perspective. They can write things that come to 
their mind after seeing what you’ve thought up! 
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ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1 ENTREPRENEURSHIP, AND 

CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1WHAT CAN YOU DREAM 

UP THAT COULD START 
TO SOLVE SOME OF THE 
CHALLENGES IN YOUR 
NEIGHBORHOOD? I

IDEATION!
Draw, write, collage, sculpt, take some time to brainstorm 
different ideas of what your dream neighborhood may look 
like, what it may have, 
what you may be able to tackle to start to see 
the place you envision! 
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ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1

1. 

2. 

3. 

4. 

5.

1. 

2. 

3. 

4. 

5.

*

EMPATHY 
INTERVIEWING

WORKING
SES SION
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YOUR 
NEXT 
BIG 
IDEA
FOR 
APPALACHIA.

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1

Now that you’ve done the first workshop, you 
may have a couple solutions or may have 
figured out that you need more information. 
What better way to make sure you’re on the 
right track than to ask questions! Write up 
at least 5 questions that you may have for 
someone in your community that will help you.
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ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1 ENTREPRENEURSHIP, AND 

CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1

1. 

2. 

3. 

4. 

5.

1. 

2. 

3. 

4. 

5.

INTERVIEW 
SOMEONE IN YOUR 
NEIGHBORHOOD!

INTERVIEW 
SOMEONE IN 
YOUR GROUP AS 
PRACTICE.
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ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

*

19

HOW CAN YOU VISUALIZE YOUR 
IDEA DEVELOPED IN WORKSHOP 
1 TO COMMUNICATE IT WITH 
OTHERS?

The Plan
1.	 Intro to Visual Design (15 minutes)

2.	 Rapid Prototyping: Sketching (15 minutes)

3.	 Make a Big Sketch

4.	 Group Crit: Present Ideas (15 minutes)

5.	 Drawing to Digital: Intro to Illustrator (15 minutes)

6.	 Drawing to Digital: Illustrator Design (30 minutes)

7.	 Cool Ends Crit Final Thoughts (15 minutes)

Activities: 
×× Sketching

×× Adobe Design Programs (Illustrator)

×× Drawing Transfer To Digital

×× Visual Design

×× Visual Identity

×× Narrative Development

Learning Objective
×× Creative Problem Solving 

×× Storytelling 

×× Creative Confidence 

×× Visual Translation 

×× Collaboration

×× Positive Feedback

VISUAL DESIGN:
OVERVIEW
DURATION:  1.5 HOURS

AUDRE LORDE

WHEN I DARE TO BE 
POWERFUL TO USE 
MY STRENGTH IN THE 
SERVICE OF MY 
VISION THEN 
IT BECOMES LESS IMPORTANT 
WHETHER I AM AFRAID.”  

\\\               \\

WORKSHOP 2:: VISUAL DESIGN

;]

2
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VISUAL DESIGN:
INTRO TO VISUAL DESIGN

;]
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*
WHAT 
IS VISUAL DESIGN

MAGAZINE DESIGN LAYOUTS!

POSTERS

PACKAGING DESIGN

LOGOS

EXHIBITION DESIGN 

AND SIGNAGE

T-SHIRT DESIGN

BOOK DESIGN
ICON &AND APP DESIGN

SOCIAL MEDIA DESIGN 

AND WEBSITE DESIGN

2
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VISUAL DESIGN:
MAKE A BIG SKETCH
15 MINUTES2SKETCH OUT SOME 

IDEAS OF HOW 
TO SOLVE THE 
CHALLENGE.
Now that you know what your neighborhood 
needs, think through how to solve it! 

VISUAL DESIGN:
RAPID PROTOTYPING
15 MINUTESDRAW A 

REPRESENTATION 
OF WHAT YOUR 
NEIGHBORHOOD 

2
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5.	 Make sure youre working in Inches

6.	 Make sure your width is set to 8.5

7.	 Make sure your height is set to 11 
 
 
 
 
 
 
 
 
 

8.	 Click create! Your screen should 
now look something like this. 
 
 
 
 
 
 
 
 

VISUAL DESIGN:
RAPID PROTOTYPING
15 MINUTES2CREATING YOUR 

ILLUSTRATOR 
DOCUMENT

3.	 Your screen should now look like 
this: 
 
 
 
 
 
 
 
 
 
 
 
 

4.	 On the right side, where it says 
“Untitled”, click on that and type your 
name.

Get Started!

Open Adobe Illustrator on your computer, 
and create a new artboard.

1.	 Find the Adobe Illustrator icon at 
the bottom of your screen and click on 
it. It should look like this: 
 
 
 
 
 
 
 
 
 

2.	 Click the “Create New” button. 
 
 
 
 
 
 

CREATING YOUR 
ILLUSTRATOR 
DOCUMENT

VISUAL DESIGN:
RAPID PROTOTYPING
15 MINUTES2

9.	 Lastly, at the very top of your 
screen, click “Window”. The fourth 
option down should say “Workspace”. 
Hover your mouse over that word and 
then click “Automation”



Shape tool: With this tool selected, click and drag to 
make a shape. Click and hold down on this tool to 
reveal more shape options!
 
 
 
 

Selection tool: Use this tool to select an object in 
order to move it around.

 
 
 
 

Color Tool: With an object selected (selection tool) 
double click on the colored box to change the color of 
an object.

 
 

VISUAL DESIGN:
HOW TO USE TOOLS2

HOW TO USE THE TOOLS

2726

THE TOOLBAR 
BASICS.

VISUAL DESIGN:
TOOLBAR BASICS

THE TOOLBAR

LINE TOOL 
Allows you to 
create a line.

TYPE TOOL 
Allows you to type.

SHAPE TOOL 
Creates shapes.

COLOR TOOL 
Choose your colors! 
The filled in square 
is for the inside of 
a shape or object; 
the hollow square 
is for the stroke of 
an object. 

SELECTION TOOL
Selects an entire 
object or shape.

2

PAINTBRUSH TOOL 
Allows you to 
draw, just like with 
a marker.

Adobe Illustrator comes with a set of tools to be 
able to draw, type and change colors. Here’s a 
review of the tools that may be important for 
your project.
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VISUAL DESIGN:
HOW TO USE TOOLS2

 

Hold your mouse over each of the tools?	

Hold the shift key while dragging your shape? 

Layer shapes on top of each other?

Select a shape with the direct selection tool?

Line tool: With this tool selected, click and drag to make a straight line.

Paintbrush tool: With this tool selected, click and drag to draw, just like with 
a pencil!

Type tool: With this tool selected, click and drag to make a text box. Now 
you can type anything you want!

Use the Character Panel to change the font style and size.

TIP: You can use the color tool to change the color of shapes, lines, and text!

HOW TO USE THE TOOLS

VISUAL DESIGN:
HOW TO USE TOOLS2 WHAT HAPPENS  

WHEN YOU....



4.	 Open Illustrator and then open 
Finder again.

5.	 Drag the image from Finder to 
your Illustrator file.

6.	 With your image selected, click on 
“Image Trace” at the top of your screen. 
 
 
 
 
 
 
 
 
 

7.	 When a box pops up, click okay.

8.	 What happened?

Take a picture or scan your drawing from 
page 23, and pull it into Illustrator. Once 
you pull in the drawing file, you should see 
an option to trace the image in Illustrator. 
What happens?

1.	 Raise your hand and ask one of 
the teachers to take a picture of your 
drawing or to scan in the drawing.

2.	 AirDrop the image or scan in the 
image to the computer you are working 
on. 

3.	 Go to the downloads folder in 
Finder and find your AirDropped or 
scanned picture. (File->Downloads) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

VISUAL DESIGN:
ILLUSTRATOR DESIGN
30 MINUTES2

TRY TRANSFERRING 
YOUR DRAWING TO 
ILLUSTRATOR!

TRY MAKING A 
COMPOSITION IN 
ILLUSTRATOR!

30

VISUAL DESIGN:
ILLUSTRATOR DESIGN2

31

Now that you know how to make shapes, draw lines, change colors, and use the type 
tool, try making a composition! What happens when you layer things? What happens 
when you play with color size and scale?

NOTE: You can create new artboards as you go along. You can also move things out-
side of your artboard. Dont worry about deleting anything, just move it around and 
save your iterations!



VISUAL DESIGN:
WORKING SESSION
2 HOURS2

SCANNED YOUR PIC 
AND WANT TO MAKE 
ALTERATIONS? OR 
WANT TO MAKE THE 
SHAPE COMPLETELY IN 
ILLUSTRATOR? 
Draw or write out some of the alterations your hoping to 
make and just dive right in! If you’re stuck, your mentor can 
point you in the right direction.  

WORKING
SES SION
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*VISUAL DESIGN2

WHEN I DARE TO BE 
POWERFUL TO USE 
MY STRENGTH IN THE 
SERVICE OF MY 
VISION THEN IT 
BECOMES LESS IMPORTANT 
WHETHER I AM AFRAID.”  

33



ILLUSTRATOR SHORTCUTS2ILLUSTRATOR SHORTCUTS2
SHORTCUTS/
HOTKEYS

SHORTCUTS/
HOTKEYS

34

Save: Command + S				   or		  File -> Save

Save As: Command + Shift + S		 or		  File -> Save As

Copy: Command + C			   or		  Edit -> Copy

Paste: Command + V			   or		  Edit -> Paste

Undo: Command + Z			   or		  Edit -> Undo

Group: Command + G			   or		  Object -> Group

Select All: Command + A			  or		  Edit -> Select All

35

Selection tool: Selects an entire object or shape

Type tool: Allows you to type

Line tool: Creates a straight line

Shape tool: Creates differnt shapes. Press 
and hold the shape tool to reveal more 
shape options

Paintbrush tool: Allows you to draw

Artboard tool: Creates a new artboard. (Another piece of 
paper)

Color tool: Double click this to pick your fill color or your 
outline color

Character: Lets you pick the font and the size of your text
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WORKSHOP 3:: INTRO TO CODING LANGUAGES,

MATT MULLENWEG

TECHNOLOGY 
IS BEST 
WHEN IT 
BRINGS 
PEOPLE 
TOGETHER.

37

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

*

37

HOW CAN YOU USE  
THE INTERNET AS A TOOL  
TO MAKE SOMETHING  
FOR YOUR IDEA?

The Plan
1.	 Introduction (5 minutes)

2.	 What can the internet do? (10 minutes)

3.	 Code a Robot (1 hour)

4.	 Questions (5 minutes)

5.	 How does coding relate to websites? (10 min)

Activities: 
×× Coding

×× Sketch

Learning Objective: 
×× HTML Coding

×× CSS Coding

×× Creative Problem Solving

×× Creative Confidence

CODING:
OVERVIEW
DURATION: 1.5 HOURS3
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CODING:
INTRODUCTION
DURATION: 1.5 HOURS

;]
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WHAT KIND 
OF THINGS CAN WE  MAKE
ON THE INTERNET

ICON &AND APP DESIGN

SOCIAL MEDIA DESIGN 

AND WEBSITE DESIGN

3

SOCIAL MEDIA DESIGN AND WEBSITE DESIGN
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CODING
WHAT IS CODE?
15 MINUTES3

CODING LANGUAGES
HOW DO WE MAKE 
THINGS ON THE 
INTERNET?

CODING
WHAT IS CODE?
15 MINUTES3

Wait a second, what is code?
Coding is made up of different programming 
languages. These languages create different 
images, colors, and designs that we see on our 
computers and phones. Code is also used to 
create video games.When you  

type this code  
in a computer...

You can make 
things for the 
internet, like this 
robot!!

HTML

CSS

JAVASCRIPT

The building blocks for our 
page.

The way our page looks, 
and the layout of our 
page; position, height, 
width, etc.

What our page does; 
animations, complex 
interactivity, updating a 
normally static page.



CODING:
BUILD A ROBOT
60 MINUTES3

4.	 To open the file we will be working 
with go to File->Open in the top menu 
on your screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.	 Open the project_3 folder in 
Brackets

1.	 On your computer, go to 
applications, and find the Brackets Icon. 

2.	 Double click the icon to open 
Brackets on your computer. 
 
 
 
 
 
 

3.	 Brackets should look like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

GET STARTED:  
FILE SETUP IN 
BRACKETS

CODING:
BUILD A ROBOT
60 MINUTES3USE CODE TO BUILD  

AN INTERNET ROBOT

42 43

Today we’re going to build 
a robot for the Internet! 



Today we’re going to play with basic 
internet styling, or what we call CSS, by 
styling out our robots face. 

1.	 Move your cursor between the 
two style brackets and click the RETURN 
button a couple of times to give 
ourselves some space. 
 
 
 
 
 
 

2.	 ADD EYES! 
Now, let’s style the first set of eyes 
to place in the location, at the size, 
we choose. To add an eye type the 
following text within the <style> 
brackets: 
 
 
 
 
 
 
 
 
 
 
 
 
Got it? Refresh your browser screen to 
see the change! 
 
 
 
 
 
 
 

USE CODE TO BUILD  
AN INTERNET ROBOT

CODING:
BUILD A ROBOT
60 MINUTES3CODING:

BUILD A ROBOT
60 MINUTES3

44 45

USE CODE TO BUILD  
AN INTERNET ROBOT

Want to play around? Try changing the 
width dimension to change the size of 
the eyes (Refresh each time).

Try changing the top & left to change 
the position of the eyes! 
 
Ready to try adding more?

Take a look at all your options. 
You could change the eyes from eyes 
1 to eyes 2 or eyes 3 by changing the 
code!

You can add more parts of your robots 
face by doing the same thing you did for 
the eyes, but for different parts that you 
see in your body list! 

Once you’ve got your robot’s eyes 
looking the way you want, you can start 
playing around with any of the other 
images on the page!

Be sure to SAVE your work after each 
change to make sure that you dont lose 
anything.
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CODING
WEBSITES3HOW DOES THIS 

RELATE TO WEBSITES ?

CODING

Content 
Management 
System

WEBSITE

CODING:
WEBISTES3
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CODING
OVERVIEW3

WORKING
SES SION
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*CODING3

TECHNOLOGY 
IS BEST 
WHEN IT 
BRINGS 
PEOPLE 
TOGETHER.



MORE INFORMATION
ON CODING3MORE INFORMATION

ON CODING3MORE INFORMATION 
ON CODING

50

What is HTML?
HTML stands for Hyper Text Markup Language, and it provides the building blocks of 
our web page.

HTML is made up of several components:

<DOCTYPE> - This tells our browser what type of page is in use

<HTML> - This tells the browser where the code for the page starts 

<HEAD> - The <HEAD> of our page provides the browser with a little more 
information about the page

<BODY> - The body includes all of the content for our page

The last three components (we’ll start calling them tags) are vitally important for our 
web page to work, if any are missing our browser will not be able to properly read 
our page. These components will also require end tags, meaning that when we are 
done adding our content to the <HTML>, <HEAD>, and <BODY> tags, we’ll need to 

add a </HTML>, </HEAD>. and </BODY> tags.

51

<!DOCTYPE>
<html>

<head>
</head>

<body>

</body>

</html>

<!DOCTYPE>
<html>

<head>
</head>

<body>
background-color: #ff00ff;

border: 3px solid #7FFF00;

</body>

</html>

HTML CSS



MORE INFORMATION 
ON CODING3 MORE INFORMATION

ON CODING3
JAVASCRIPTIDS VS CLASSES

52

IDS

IDs can only be used once, and only one ID can be used per element.

Style rules for IDs always follow the following syntax:

CLASSES

Classes can be used multiple times, and multiple classes can be used 
per element.

Style rules for classes always follow the following syntax:

53

So, we can think of the three components that we’ve discussed, HTML, 
CSS, and Javascript, as being layers of a webpage:

HTML

CSS

JAVASCRIPT

The building blocks for our 
page.

The way our page looks, 
and the layout of our 
page; position, height, 
width, etc.

What our page does; 
animations, complex 
interactivity, updating a 
normally static page.

IDs and classes are labels to allow us to connect 
to our styles to elements in our webpage. There 
are two primary differences between IDs and 
classes.

Javascript is a programming language that allows us to 
implement complex interactions on a webpage. Any time 
that we want a page to do something other than be static, 
we can accomplish this through the use of javascript.
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WORKSHOPS 4 AND 5.:: VISUAL DESIGN AND TECH START UP TRACKS

IN WORKSHOPS 4 AND 5 YOU HAVE THE OPTION TO CHOOSE A 
TRACK. IF YOU WANT TO FOCUS ON VISUAL DESIGN ONLY, FOLLOW 
THE TEAL WORKING SESSIONS. IF YOU WANT TO FOCUS ON TECH 
ONLY, FOLLOW THE PINK WORKING SESSIONS. OR YOU CAN DO 
THEM ALL!. THE CHOICE IS YOURS. 

YOU ALWAYS 
HAVE A CHOICE.
DO YOU WANT TO DO VISUAL DESIGN. 
OR TECH. OR BOTH. THE WORLD 
IS YOUR OYSTER.
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GET READY TO 
DESIGN 
YOUR 
HEART 
OUT

WORKSHOP 4A. VISUAL DESIGN TRACK

VISUAL DESIGN

:]

;]

;*

\\\               \\

\\\               \\

;]

*

A

57

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

*
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HOW CAN YOU DESIGN A POSTER 
TO COMMUNICATE YOUR IDEAS 
IN YOUR NEIGHBORHOOD?

The Plan
1.	 Graphic Design 101: Color Theory, Typography,  

		  & Imagery (15 minutes)

2.	 Digital Design with Illustrator: Design Your Poster  (60 minutes)

3.	 Illustrator Gone Wild: Iterate! Make it Your Own (15 Minutes)

4.	 Group Crit: Present Ideas (15 minutes)

5.	 Cool Ends: Final Thoughts + Next Steps!  

		  Printing, Hanging in your Community (15 minutes)

Activities: 
×× Sketching

×× Adobe Design Programs (Illustrator)

×× Drawing Transfer To Digital

×× Visual Design

×× Visual Identity

×× Narrative Development

Learning Objective
×× Creative Problem Solving 

×× Storytelling 

×× Creative Confidence 

×× Visual Translation 

×× Collaboration

×× Positive Feedback

VISUAL DESIGN:
OVERVIEW
DURATION: 1.5 HOURS4



5958

COLOR/COLOR 
THEORY

3 ELEMENTS OF 
DESIGN

COLOR
Warm colors: Red, yellow, and 
orange are considered warm 
because they remind us of things 
that are warm/hot such as the sun 
or fire.

Cool colors: Blue, green, and purple 
are considered cool because they 
remind us of things that are cool/
cold such as water or grass.

 
 
 
 

VISUAL DESIGN
15 MINUTES

4

Yellow
Primary Yellow Orange

Tertiary

Orange
Secondary

Red Orange
Tertiary

Red
Primary

Red Violet
Tertiary

Violet
Secondary

Blue Violet
Tertiary

Blue
Primary

Blue Green
Tertiary

Green
Secondary

Yellow Green
Tertiary

Primary
Yellow
Red
Blue

Secondary
Orange
Violet
Green

Tertiary
Yellow Orange
Red Orange
Red Violet
Blue Violet
Blue Green

Yellow Green

VISUAL DESIGN4

TYPOGRAPHY
Typograohy is the visual art of 
choosing fonts and creating type 
on a page in order to help people 
better understand the meaning of 
your art.

IMAGES
Pictures that are added to your art 
to help people better understand 
the meaning of your art.
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IMAGESTYPOGRAPHY

A B C D E F G H I J K L M N 
O P Q R S T U V W X Y Z
a b c d e f g h i j k l n m o p 
q r s t u v w x y z
1 2 3 4 5 6 7 8 9 0
! @ # $ % ^ & * ( ) - = + / ?

A B C D E F G H I J K L M N 
O P Q R S T U V W X Y Z
a b c d e f g h i j k l n m o p 
q r s t u v w x y z
1 2 3 4 5 6 7 8 9 0
! @ # $ % ^ & * ( ) - = + / ?

VISUAL DESIGN4 VISUAL DESIGN4
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POSTER DESIGNPOSTER DESIGN

Composition 1: Diagonal

Background color

Type

Imagery

VISUAL DESIGN

Try typing a
message about 
your project in
this space!

4

Composition 3: AbstractComposition 2: Center

Try typing a
message about 
your project in

this space!
Try typing a

message in

this space

in thisspace

and in this space!

VISUAL DESIGN4
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POSTER DESIGNPOSTER DESIGN

Composition 1: Diagonal

Background color

Type

Imagery

VISUAL DESIGN

Try typing a
message about 
your project in
this space!

4

Composition 3: AbstractComposition 2: Center

Try typing a 
message about 
your project in 

this space!

Try typing a

message in 

this space

in this
space

and in this space!

VISUAL DESIGN4
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VISUAL DESIGN4 VISUAL DESIGN4
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WHAT 
CAN YOU MAKE 
WITH ILLUSTRATOR

POSTERS

LABEL DESIGN

STICKERS

BUSINESS CARDS

BUTTONS PRODUCT DESIGN

MAPS

POSTCARDS

BOOK COVERS

CHARACTERS

WEBSITES

LETTERHEADS, BUSINESS 
CARDS, ENVELOPES, AND MORE!

ILLUSTRATIONS

LOGOS

MAPS
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VISUAL DESIGN4 VISUAL DESIGN4
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VISUAL DESIGN4 VISUAL DESIGN4
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VISUAL DESIGN

WORKING SESSION

4
FURTHER EXPLORE 
YOUR IDEAS.

VISUAL DESIGN

WORKING SESSION
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BILL GATES

WE'RE 
CHANGING THE 
WORLD 
WITH 
TECHNOLOGY

WORKSHOP 4B. CODING TRACK

CODINGB

75

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

*

75

HOW CAN YOU USE TECHNOLOGY 
TO HELP YOUR IDEA DEVELOPED 
IN WORKSHOPS 1 AND 2?

The Plan
1.	 Introduction (5 minutes)

2.	 Log into your Wordpress website (15 minutes)

3.	 Build your own Wordpress website (1.5 hours)

4.	 Questions (10 minutes)

Activities: 
×× Coding

Learning Objective: 
×× HTML Coding

×× CSS Coding

×× Creative Problem Solving

×× Creative Confidence

CODING
OVERVIEW
DURATION: 1.5 HOURS4
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CODING4

77

CODING4BUILD A 
WORDPRESS 
WEBSITE

BUILD A 
WORDPRESS 
WEBSITE
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BUILD YOUR OWN 
WEBSITE ON 
WORDPRESS

CODING4 EDITING COLORS 
AND FONTS

CODING4

Today, we’re going to build a basic Wordpress website. The link for your website will 
be provided to you at the beginning of the workshop. Once created, you’ll be able to 
work on, and make changes to your website any time you like by using the URL for your 
specific website.

Ready? Let’s dive right in! 

Logging in:
Start out by logging into the website that 
we’ve created for you.

First, open Chrome by clicking the Chrome 
icon at the bottom of your desktop. The 
icon looks like this:
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the URL for your website in the URL 
bar in chrome.

http://makeshopappalachia.meshfresh.
com/firstname/wp-admin

Replace “firstname” with your first name. 
Then, press the RETURN key to log in.

On the login screen enter your username 
and password. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Replace firstname with your first name. 
Your password will be the same as the 
password for the laptops.

Once logged in, click the Global 
website settings link to start setting 
up the colors, fonts, and contact 
information for your website. 

First try playing with the colors and 
font options. Each time you want to 
see what your selection looks like, 
click the UPDATE button on the right, 
then click MY NEW WEBSITE at the 
top of your window!
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CODING4 CODING4LET'S SET UP YOUR 
HOMEPAGE

Start by clicking the Pages link in the 
left-hand menu.

Then click the page name for the page 
we’re going to be working on. Your  
website will only have 1 page, so click the 
word “Home”, like what you see in the  
image below.

LET'S SET UP YOUR 
HOMEPAGE

Your page should look like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If it doesn’t, raise your hand and ask for 
help.
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CODING4 CODING4
ADD YOUR FIRST IMAGE!

In the CMS, the first part of the page is 
the Welcome Gate, this creates the top 
most part of your page. See the image for 
the finished test website below.

ADD YOUR FIRST IMAGE!

On your version, let’s start with the 
background image. For this step, make 
sure that you have a Large image.

To update the background image, click 
“Add Image” in the Background Image 
field. 
 
 
 
 
 
 
 
 
Once you click “Add Image”, you 
will see the Media Library tool.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click the “Select Files” button and choose 
the image you want to use from the 
images you chose earlier, and then click 
the “Select” button.  

You should see a tiny version of your
 image under Background Image, if you 
don’t, try the steps again, or ask.
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CODING4 CODING4
ADD YOUR FIRST IMAGE!

Once you’ve updated your background 
image, click the update button.
 
 
 
 
 
 
Then click “View Page” at the top of the 
page in order to preview your work. 
 
 
 
 
 
What do you see?  
How does your page look?  Are you happy 
with the image you chose?  

If you aren’t seeing anything, or you’re 
having issues, try the steps above again, 
or raise your hand for help.

ADD TEXT TO YOUR 
HOMEPAGE

If you aren’t already there, click the “Edit 
Page” link at the top of your screen to 
return to the CMS editor. 
 
 
 
 
 
Now start filling out the rest of the fields 
in the Welcome Gate section to finish 
building the first panel of your new page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Be sure to click the Update button 
periodically to make sure that you don’t 
lose any work, and view your page 
periodically to preview your changes!
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CODING4 CODING4
ADD NEW PANELS!

Once you’ve finished with the Welcome 
Gate, it’s time to start working on the rest 
of your page!  Other sections of your page 
are made up of Panels.  To start building 
these panels, click the “Add Panel”  
button. 
 
 
 
 
 
Your page has 3 panel types, an Intro 
Panel, a Cards Panel, and a Text Panel, 
each with their own characteristics.  Play 
around with adding some content to one 
of the panel types and see what it 
produces on your page.

Here are some examples of the different 
panel types used on our example website:

Intro Panel 
 
 
 
 
 
 
 
 
 
 
 
 
 
Cards Panel

ADD NEW PANELS!

Text Panel 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Special Note: As you are creating your 
panels, make note of the Panel ID field. 
 
 
 
 
 
 
 
 
 
 
 
Make sure that you read the instructions 
in this field, and you are adding a short, 
1 - 2 word description for this panel.  We’ll 
need that for the next step, making the 

navigation. Keep in mind as you do so, 
that the IDs you create here will be used 
for your navigation, you set up this part in 
when you were planning your website.
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CODING4 CODING4BUILD YOUR WEBSITE 
MENU

Refer to the list of pages you created in 
the planning step. What you came up 
with there will be the labels for our 
navigation. To start, click Appearance in 
the left navigation in the CMS, and then 
click Menus. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You should see this:

BUILD YOUR WEBSITE 
MENU

Start creating your navigation by 
selecting “Custom Links” under Pages. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Remember the Panel IDs you set up when 
you built your page? If you don’t save your 
work by clicking the Save Menu button, 
and take a look at your page. You may 
want to write your panel IDs down.

The panel ID will then be the URL for your 
custom link.  Add that information by 
typing:

#Panel-ID

Into the URL field.  Your link text will use 
the text you wrote in the planning stage 
for each of your content sections
Click the “Add to Menu” button to add 
your link to the menu.  Once complete 
save your menu, and preview your page 
by clicking the View Page button.  

If everything is OK, stand back and 
admire your work!  You’ve just made your 
first website.  If you need help, please 
raise your hand to ask for help.
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CODING4
WORKING SESSIONFURTHER EXPLORE 

YOUR IDEAS.

CODING4
WORKING SESSION



HAPPINESS LIES 
IN THE JOY  OF 
ACHIEVEMENT AND 
THE THRILL OF 
CREATIVE 
EFFORT.

WORKSHOP 5A. VISUAL DESIGN TRACK

VISUAL DESIGN
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FRANKLIN D. ROOSEVELT

A

93

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

*
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HOW CAN YOU DESIGN A POSTER 
TO COMMUNICATE YOUR IDEAS 
IN YOUR NEIGHBORHOOD?

The Plan
1.	 ??????

2.	 ????

3.	 ??????

Activities: 
×× ??????

×× ?????

×× ??????

Learning Objective
×× ????

×× ?????

×× ???????

VISUAL DESIGN:
OVERVIEW
DURATION:  HOURS5
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ALBERT EINSTEIN

CREATIVITY 
IS CONTAGIOUS
PASS  IT 
ON

WORKSHOP 5B. CODING TRACK

CODINGB

95

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

*

95

HOW CAN YOU USE TECHNOLOGY 
TO HELP YOUR IDEA DEVELOPED 
IN WORKSHOPS 1 AND 2?

The Plan
1.	 Wordpress continued

Activities: 
×× Coding

Learning Objective: 
×× HTML Coding

×× CSS Coding

×× Creative Problem Solving

×× Creative Confidence

CODING
OVERVIEW
DURATION: 1.5 HOURS5
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CODING5
WORDPRESS

Okay now that we’ve gotten a taste of 
wordpress, ready to add your own pages, 
text, and images?

1.	 Design your own sitemap! What 
do we want our website to be about? 
Think about what you worked on in the 
Big Idea workshop and how making a 
website can help out with your goal.

2.	 Gather your images! We’re going 
to take some time to find some images 
we want to use on the website to make 
it look great, and we’ll look at ways that 
we can quickly add some text.

3.	 Build your own website on 
wordpress! Once we have our website 
planned and our information gathered, 
we’re going to add that content to our 
website! 
 
Think about your Big Idea project, and 
what you want the world to know about 
it. What information should go on your 
website? Brainstorm some ideas below: 
 
 
 
 
 
 
 

 
Now, what order should this information 
appear on your website? Is there 
anything else you need to add? Many 
websites have an About section, 
additional sections that go into more 
depth about your project or idea or 
cause, and maybe a little bit about the 
people involved.

Let’s add numbers to our list  of website 
information above, in the order we want 
the information to appear on the website. 

If you need examples, take a look at the 
way the content is broken up in our 
example:

CODING5GATHER IMAGES FOR 
YOUR WEBSITE

Search Google for some images to be 
used on your website. You could also use 
your own photos, or graphics that you 
made in the Design workshop. Use the 
examples below to find several different 
sizes that can be used.

Large Images: for backgrounds 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Medium Images: to pair with text

Small Images: for example a portrait, or 
your website’s logo 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now that you have your own menu, 
images, and writing, it’s time for you to 
upload everything and design and build 
your own website on wordpress. Refer 
back to workshop 4 for tips, tricks, and 
reminders on how to use wordpress to 
make your own website.
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CODING

WORKING SESSION

5
FURTHER EXPLORE 
YOUR IDEAS

CODING

WORKING SESSION

5
FURTHER EXPLORE 
YOUR IDEAS
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WORKSHOP 6.:: MINI-PITCH COMPETITION

AUSTIN KLEON

THE ONLY WAY TO  
FIND YOUR 
VOICE  
IS TO 
USE 
IT.

101

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING

*

101

WHAT DO I NEED TO FINALIZE MY 
PROJECT IDEA AND PROPOSE IT 
TO POTENTIAL PARTNERS THAT 
CAN HELP ME BRING IT TO LIFE ?

Agenda: 2 Hour Session
1.	 Group Share & Feedback (15 minutes)

2.	 Idea Festival Presentation Tips (10 minutes)

3.	 Idea Festival Prep: Questions for Mentors (10 minutes)

4.	 Work Session: Continued development of your idea (45 minutes)

5.	 Group Sharing and Q&A for Idea Festival Prep (10 minutes)

IDEA FESTIVAL6
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1. 

2. 

3. 

4. 

5.

1. 

2. 

3. 

4. 

5.

6 IDEA FESTIVAL
GROUP SHARE &AND FEEDBACK
(15 MINUTESPROJECT SHARING.

WHAT DID YOU 
LIKE ABOUT OTHER 
FOLKS PROJECTS  ?

IDEA FESTIVAL
PRESENTATION TIPS
10 MINUTES6WHAT PRESENTATION 

TIPS ARE WORTH 
NOTING DOWN  ?
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1. 

2. 

3. 

4. 

5.

6 IDEA FESTIVAL PREP
QUESTIONS FOR MENTORS
10 MINUTESWRITE OUT FIVE OF 

YOUR QUESTIONS 
FOR YOUR 
MENTORS AT THE 

MENTOR ANSWER :)

MENTOR ANSWER :)

MENTOR ANSWER :)

MENTOR ANSWER :)

MENTOR ANSWER :)

HI! NICE TO MEET YOU! ! WHAT IS YOUR NAME AND YOUR JOB IN OUR TOWN??

IDEA FESTIVAL CONTIN?UE 
DEVELOPMENT OF YOUR IDEA 
45 MINUTES6

WRITE OR DRAW 
YOUR PLAN FOR 
PRESENTING YOUR 
BIG IDEA TO YOUR 
COMMUNITY!
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1. 

2. 

3. 

4. 

5.

6 IDEA FESTIVAL 
WORKING WITH A MENTORWHAT IDEAS FROM 

YOUR MENTOR 
WERE HELPFUL 
FOR YOU TO MAKE 

IDEA FESTIVAL
MINDMAP WITH A MENTOR6TEACH YOUR 

MENTOR HOW TO 
MINDMAP !
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As everyone introduces themselves,  
make a sketch below of everyone!  

ENTREPRENEURSHIP, AND 
CREATIVE PROBLEM SOLVING 
THROUGH DESIGN THINKING1

SAY HELLO!

Welcome to the Makeshop Entrepreneurship 
Workshops! This is the time to say helloooo to 
your neighbors--we’re about to jump into a real 
adventure together. 

Go around the group and introduce yourself with 
your name, your favorite color, and your favorite 
thing about the place you live!
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AUSTIN KLEON

THE ONLY WAY TO  
FIND YOUR 
VOICE  
IS TO 
USE 
IT.

THANK YOU FOR BEING A 

MAKESHOP 
MENTOR! 

FOR

ADMINISTERED BY:

;]
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SAY HELLO!
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MATT MULLENWEG

TECHNOLOGY 
IS BEST 
WHEN IT 
BRINGS 
PEOPLE 
TOGETHER.

MAKESHOP APPALACHIA

LEVEL ONE
CODER

FOR:

ADMINISTERED BY
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AUDRE LORDE

WHEN I DARE TO BE 
POWERFUL TO USE 
MY STRENGTH IN THE 
SERVICE OF MY 
VISION THEN 
IT BECOMES LESS IMPORTANT 
WHETHER I AM AFRAID.”  
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MAKESHOP APPALACHIA

LEVEL ONE
DESIGNER

FOR:

ADMINISTERED BY:

;]
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1.	 Open the brackets application

2.	 For this project, we’ll be usign 
HTML, CSS, and just a tiny 			 
bit of Javascript, that I’ll be providing

3.	 Go to https://bgclub.meshfresh.
com/penguin

POPUP PENGUIN GAME
CODING4

4.	 Click the link to download the 
project_2 file, project_2.zip

5.	 Once the file is downloaded, unzip 
the file by double 				  
clicking the file on the desktop.

6.	 Follow along while we create a 
game using HTML, CSS, 			 
and Javascript that will end up looking 
like this:

POPUP PENGUIN GAME
CODING4

Steps: 

1.	 Open the project_2 folder with 
Brackets. The easiest way to do this is 
to drag the folder icon to the Brackets 
icon in the taskbar.

2.	 In this project, we’ll be focusing 
on some advanced CSS, so our HTML 
file already includes all of the building 
blocks we’ll need.

3.	 Lets preview the index.html file 
using live preview. Click the live preview 
button in Brackets (sideways lightning 
bolt) This is what we should see with our 
preview:

Theres not much there, right? Don’t worry, we’ll be adding more as we 
build this page.
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POPUP PENGUIN GAME
CODING4

1.	 Lets take a look at what we have 
in this folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Our image folder contains all of the 
images we’ll be using for our game.

2.	 Let’s go ahead and start adding 
some styling for our penguins. Between 
our <style> <style/> tags type:

3.	 Let’s break this down a bit to see 
if we can figure out what’s going on in 
our CSS. 
 
 
 
 
 
 
 
 
 
 
Notice that the first two style rules 
for our .penguin1 class include the 
additional elements :hover and :active. 
These additional elements are called 
pseudo classes, and they are used 
to create interactivity when a user 
interacts with an element with their 
mouse.

:hover - updates the element according 
to the style rules we have 			 
included when the user places their cursor 
over the element in question.

:active - updates the element according 
to the style rules we have 			 
included when the user clicks the element.

POPUP PENGUIN GAME
CODING4

4.	 The rest of our styles for this 
page will be similar to our example 
above. Copy the lines that we typed 
in the previous step, and below 		
the “.penguin1:active” style, paste an 
additional copy of our penguin1 code. 
 
Update each of the lines in the copy to 
remove the “1” and replace it with a “2”, 
it should look like this:

5.	 Continue to make copies of these 
lines just after your last paste, and 
increasing the number lines by 1 each 
time. So your next paste would replace 
the “1” characters with a “3”. and so on; 
untill you have reached the number 8.

6.	 After your 8th penguin type: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Be sure to SAVE your work!
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1.	 All of our styling has now been completed. Our page should look like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Try interacting with any of the clouds with your cursor. What happens when you hover 
over them? What happens when you click your mouse while hovering over the clouds?

POPUP PENGUIN GAME
CODING4

POPUP PENGUIN GAME
CODING4

2.	The next step is to add some Javascript. Find the index.js file and type the 
following code:
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NOW THAT YOU 
HAVE CODED SOME 
GAMES, WHAT DO 
YOU WANT TO MAKE 
FOR YOUR PROJECT?

CODING

WORKING SESSION

4

Work with your mentor to begin coding 
something that you can use with your project, 
like an app, a website, or maybe you want to 
make your poster digital!

FURTHER EXPLORE 
YOUR IDEAS

CODING

WORKING SESSION

4
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1.	 Open the brackets application

2.	 Go to https://bgclub.meshfresh.com/, this is the finished version of what you 	
		  could create

3.	 Download the .zip file for this project, and save it to the desktop

4.	 Once the file is downloaded, unzip the file by double clicking the file on the 	
		  desktop.

5.	 Open the index.html file using Brackets. You should see something that looks 
like this: 
 

Today we’re going to create a story with code!  This is just an example, but our 
finished project is going to look something like this:

TELL A STORY
CODING5

TELL A STORY
CODING5

In your project folders, you’ll find a bunch of images, including the ones in the 
finished example, that you can use to create your story.  Like these: 
 

The styling for all of the blocks you’ll be creating is already done for you.  The 
primary thing that we’re going to be focusing on in this project is writing a story 
with your website.  A big part of creating a website is creating a story, something 
that we can use to entertain people, and keep their attention.
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TELL A STORY
CODING5

Since we’re trying to create a visual story, a good place to start with the develop 
your story is to create something called a storyboard.  A storyboard shows all of 
the different scenes that you are planning to create in your story.  Spend the next 
few minutes storyboarding for the story that you’re trying to write.  Your drawings 
don’t need to be perfect, pay more attention to the text that you want to write, 
and do quick sketches of the images that you want to use.  

TELL A STORY
CODING5



127126

1.	 Making new frames for your story is easy!  Just copy this portion of the code 	
		  on your example file:

2.	 And paste your copied frame just below the content you just copied.  Your 	
	 code should look just like this

3.	Save your work and preview the page in your browser. It should now look like 
this:

4.	In order to personalize your frames with the images you want to use, you can 
update the image for each of your story frames by updating the image:

CODING5
TELL A STORY

CODING

TELL A STORY

5.	In the screenshot (and the example of what the page should look like above), 
we’re using the image sun.png.  Your project folders contain several more 
images that can be used for your story.  Here’s a list of all the filenames if you 
want to use those images:

6.	To use any of the images above, just replace the text “sun.png” with any of 
the file names above.  As an example, we’ll use the boy.png image to update 
the first frame in our example:

7.	 SAVE your work, and reload your preview.  You should see this:

5
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TELL A STORY

1.	 Now let’s update the caption for our first frame. In order to do that, we’ll 
change the content within the <p></p> tag:

2.	Let’s update the content in the first frame on our page:

3.	SAVE your work, and reload your preview page to see the change:  As you 
start to write your story, be sure that you are writing short sentences for each 
frame, too much content, and your image won’t show!  If needed you can 
always break your content up across multiple frames.

4.	Let’s back up a second and personalize your story by giving it a title. Find this 
section in the code of your page:

5.	To add your new title, delete everything between the two <h1></h1> tags and 
include what you want for your new title.  Save your work, and preview the 
page again.

6.	Now it’s time to start writing your story and turning it into a webpage!  Write 
anything you want, from a short story about dragons finding a diamond, to a 
joke, the choice is yours!

CODING5
FURTHER EXPLORE 
YOUR IDEAS

CODING

WORKING SESSION

5


